Nuance Power PDF Advanced.

An overview and walkthrough of the primary features and functionality of Power PDF for product reviewers.
Contents

WELCOME!.................................................................................................................................................. 4

Welcome to your Nuance Power PDF Advanced evaluation! ......................................................... 4

About this Guide ........................................................................................................................................ 4

Uncompromised functionality............................................................................................................... 4

TERMS YOU MAY SEE IN THIS GUIDE ............................................................................................ 5

POPULAR USES OF PDF......................................................................................................................... 6

EVALUATING POWER PDF ADVANCED ............................................................................................... 6

WHAT MAKES POWER PDF ADVANCED DIFFERENT FROM POWER PDF STANDARD? .......... 6

PDF FILE CREATION ............................................................................................................................... 8

Creating PDF files from other formats ............................................................................................... 8

PRINT TO PDF ......................................................................................................................................... 8

CREATION BY OPENING A DOCUMENT WITHIN POWER PDF ........................................................ 8

Creating a PDF file is as simple as opening a file .............................................................................. 8

CREATE PDF DOCUMENT FROM WITHIN POWER PDF .................................................................... 9

ONE-CLICK PDF CREATION ICONS FROM WITHIN MICROSOFT WORD, EXCEL, POWERPOINT AND OUTLOOK .............................................................................................................. 10

ONE-CLICK PDF CREATION FROM WITHIN INTERNET EXPLORER ............................................. 10

BATCH CREATE PDF FILES USING THE PDF CREATE ASSISTANT .................................................. 10

Creating creation profiles ..................................................................................................................... 11

PDF PACKAGES and Portfolios ............................................................................................................. 12

Creating a Portfolio by combining multiple documents and document types .................................. 12

PDF CONVERSION ................................................................................................................................. 14

Converting PDF Files into Other Formats ......................................................................................... 14

CONVERT PDF TO OFFICE & OTHER FORMATS ............................................................................... 14

Convert to Microsoft Word/Excel ....................................................................................................... 14

CONVERT IMAGE PDFs TO SEARCHABLE PDF ................................................................................ 15

THE AUTO-DETECT IMAGE-ONLY FEATURE –CREATE EDITABLE PDF FILES FROM SCANNED IMAGES ................................................................. 16

EXPORT AN AREA ................................................................................................................................. 17
WELCOME!

WELCOME TO YOUR NUANCE POWER PDF ADVANCED EVALUATION!

Thank you for taking the time to evaluate Nuance Power PDF Advanced and our commitment to “PDF for Business.” Power PDF Advanced, the latest version of Nuance’s flagship enterprise-ready desktop PDF solution, is the smart replacement for Adobe Acrobat. It enables business users to create, view, edit, convert, and collaborate with 100% industry-standard PDF files to deliver maximum value without compromising functionality or ease of use.

At Nuance we’re focused on helping you work faster, and enabling you to do things with PDF you might not know were possible. To that end; we’ve created tools designed to save you time - lots of time. Power PDF Advanced supports effortless creation of 100% industry-standard PDF files and the most accurate conversion of PDF files to Microsoft Word, Excel, PowerPoint and Corel WordPerfect documents. It also provides unique features such as word processor-like editing, workflow controls for processing hundreds of files at a time, cloud connectivity, PDF security, and Dragon Notes speech recognition to dramatically increase business productivity at a surprisingly affordable price.

With all the business features you need in an application that’s easier to use, easier to license, easier on your schedule and easier on your budget, Power PDF Advanced is the uncompromised choice.

ABOUT THIS GUIDE

This guide serves two purposes: First and foremost it provides a walkthrough of the Power PDF Advanced application, while at the same time calling out some of the key questions that should be addressed when evaluating any PDF solution. This guide does not cover every aspect of the Power PDF Advanced application, but it strives to show the major functional groupings of functionality and points out some of the more advanced, and time saving features. Notably missing from this guide are examples of using the Forms and encryption and signature features. These will be covered in a subsequent guide.

UNCOMPROMISED FUNCTIONALITY

At Nuance we talk about delivering an uncompromising experience for businesses large and small:

- It means delivering a PDF product designed specifically for business users; with business innovations designed to save you time and increase your productivity.
- It means better PDF pricing, pricing designed to get PDF on every desktop in your organization, eliminating the difficult tasks of deciding who gets what functionality, and having to manage more than one PDF solution to meet your organizational and budgetary needs.
- It means easy-to-understand, 1-page licensing programs designed with you in mind, without seat counting requirements or audits enabling you to predictably plan and budget for your PDF needs.
- What we’ve built at Nuance, is a PDF application and a PDF licensing program that really works better for business. PDF for Business means PDF purpose-built for business.
**TERMS YOU MAY SEE IN THIS GUIDE**

**Creation** – The process of taking a document in some format, and using that file as the source for creating a PDF file.

**Conversion** – The process of taking a PDF file and turning it back into a fully-formatted, editable document in another format such as Word, Excel, PowerPoint, and WordPerfect.

**OCR** – OCR stands for Optical Character Recognition or the process of identifying and inserting text based only on recognizing the characters from an image or picture.

**Image-only PDF** – Image-only PDF refers to a type of PDF file that was created either by a scanner or was created using a “Print as Image” setting into the PDF format. Image-only PDF files are literally just pictures of the pages of the document with no textual information associated with them. As a result, image-only PDF files cannot support text searching or editing unless they have been converted to a Searchable PDF.

**Searchable PDF** – Searchable PDF refers to an Image-only PDF that has been converted using OCR. In that conversion process the text from the image-only PDF is recognized and inserted invisibly behind the image of the page. The result is a file that looks like an image-only or scanned document, but has searchable text hidden within the file. You can perform text based searches and redact content from a searchable PDF. Something you can’t do with an image only PDF.

**PDF Normal** – PDF Normal refers to a PDF file that was created from a digital document (such as Word, Excel, etc.) As a result, PDF normal files can be searched and edited natively within PDF solutions, without the need to run a conversion.

**Document Assembly** – Document Assembly refers to the process of creating a single PDF file from multiple source files. Document assembly can also refer to the ability to re-arrange pages within the document; replace, extract or delete pages from the document; and taking any necessary steps, such as updating headers/footers, table of content and page numbers, to provide a single unified document.

**PDF Packages** – PDF Packages are a collection of files, both PDF and other file types, stored within a PDF “wrapper” similar to the Winzip process. Packages provide a mechanism for organizing your documents into a single grouping rather than sharing multiple individual files. PDF Packages differ from document assembly in that within a PDF Package each file is discrete, not merged with the other files. As a result, each document can have its own security settings within the package.

**PDF Portfolios** – PDF Portfolios are the next generation of PDF Packages. Where Packages allow you to include PDF and other file types, Portfolios allow you to include PDF, other file types, and even folders. Now you can build entire folder hierarchies within a single PDF file with a much more polished presentation layer that can include video or flash instructions on how to utilize the files within the Portfolio.

**DMS** – DMS stands for Document Management Systems, server based solutions that act as a repository for an organization’s documents. Power PDF Advanced supports a wide range of popular document management systems natively within the UI.
The Portable Document Format (PDF) was created in 1993 to help alleviate the problems associated with electronic document exchange. PDF files were designed as a way to encapsulate a complete document description that included text, fonts, images, and vector graphics, in a compressed universally readable format.

PDF has become the de facto standard for digital document collaboration in the workplace. As an approved ISO standard, a standard that is implemented by over 1,800 hardware and software vendors, a PDF is a PDF no matter what manufacturer’s software was used to create it.

In addition to document exchange, some of the more popular operation applied to PDF files include:

- Document assembly / Document splitting
- Document sharing and collaboration
- Document markup or annotating documents
- Archiving documents / Archiving mail
- Online form filling and form creation
- Applying security to documents

EVALUATING POWER PDF ADVANCED

Power PDF Advanced is the complete PDF solution designed specifically for the business user. With more than 3,000,000 seats sold and supported, business professionals worldwide are making Nuance PDF software their first choice. Create 100% industry-standard PDF files from any PC application. Power PDF Advanced accurately converts PDF files into fully-formatted Microsoft Word™, Excel®, PowerPoint®, XPS, and Corel® WordPerfect® documents that you can edit. Using the intuitive interface, your favorite features will be right at your fingertips, making Power PDF Advanced one of the easiest PDF applications to use.

WHAT MAKES POWER PDF ADVANCED DIFFERENT FROM POWER PDF STANDARD?

Power PDF Advanced has been designed with a more robust feature set specifically designed for medium to large organizations. Conversely Power PDF Standard has been designed as home or home office product.

- Power PDF Advanced offers all of the functionality within Power PDF Standard, plus:
  - Redaction – The ability to permanently remove “sensitive” information such as social security numbers or addresses from within PDF documents (commonly referred to as “blacking out” information)
  - Bates Stamping and advanced header and footer functionality – Create custom stamping profiles for stamping information into headers and footers
  - Ability create and send PDF files to DMS from E\M-I Portfolio interface or Internet Explorer
  - API layer for controlling functions within the application in order to create custom-coded workflows
  - Network Deployment Configuration Tools – Support for WTS and Citrix deployments as well as a “configurator” which allows the IT administrator to determine and customize which functionality within the application and which application default settings are pushed to your users
  - Installer customization for enterprise deployment
  - Support for network scanning and eCopy ShareScan with monitored Email Inboxes
- Certified with Citrix® and Windows Terminal Services (Thin Client Deployment/Use)
- PDF/A (a1/b1, a2/b2/2U, 3a/3b/3u) and 508 Compliance Checker – Including the ability to fix files that do not comply with PDF/A or 508 Accessibility regulations.
- Watched Folder and Batch sequence capabilities to automate common tasks and move files from one location to another
PDF FILE CREATION

Document creation questions to ask when considering a PDF solution:

- Am I able to create a PDF file from within MS Office?
- Can I create a PDF from within Internet Explorer?
- Can a PDF be created from a Word document without running Word?
- Can I combine multiple documents into one PDF file?
- Can I batch create (creating multiple files with one command)?
- Can I create PDF files easily?

CREATING PDF FILES FROM OTHER FORMATS

Power PDF Advanced offers a variety of methods for creating PDF files. Some of the methods are described below.

PRINT TO PDF

Printing to PDF using a “PDF Print Driver” is the most common method for creating PDF files. Using this method limits you to a single file at a time and prevents the conversion of object tags or other metadata commonly used in Office documents. To print from any application use the Nuance PDF print driver.

1. Open a document in Microsoft Word. Choose the File menu and then Choose Print.
2. Select the Nuance PDF printer driver from the list of available printers. Click Print
3. Select a location to save the PDF.

CREATION BY OPENING A DOCUMENT WITHIN POWER PDF

CREATING A PDF FILE IS AS SIMPLE AS OPENING A FILE.

1. Within Power PDF Advanced, choose the File menu, then Open.
2. Change the “Files of Type” field to “All Files (*.*)”.
3. Then simply select the file you’d like to turn into a PDF and click Open.
4. The PDF file will be generated from the selected document.
CREATE PDF DOCUMENT FROM WITHIN POWER PDF

Power PDF also offers a variety of PDF creation methods directly within the application. Click the New PDF menu item from within the File Menu then select one of the actions from the window pane to select the type of a PDF document you want to create:

1. From Scanner – Creates a PDF file directly from your attached scanner
2. From file – Gives you 4 choices
   i. Creates a single PDF document from a selected file
   ii. Create multiple files – Launches the PDF Create Assistant to create multiple PDF documents from multiple source files
   iii. Combine multiple files – Launches the PDF Create Assistant to create a single PDF document from multiple source files
   iv. Overlay multiple files – Launches the PDF Create Assistant to create a single PDF document by overlaying multiple source files
3. From the clipboard – Creates a PDF file from the content that is currently stored on the clipboard
4. Blank PDF – Provides a blank PDF page with which you can start adding content
5. Create a PDF Portfolio – will generate an empty portfolio to add content to
ONE-CLICK PDF CREATION ICONS FROM WITHIN MICROSOFT WORD, EXCEL, POWERPOINT AND OUTLOOK

1. With the document open, click on the Nuance PDF ribbon
2. Select the Create PDF button, which will open the Create Assistant
3. You can use the Creation Settings button to select specific PDF file creation options
4. Select a location to save the resulting PDF file

ONE-CLICK PDF CREATION FROM WITHIN INTERNET EXPLORER

Create; Create and add to existing PDF; Create and send in e-mail; or Create and Send to DMS directly from your IE toolbar.

BATCH CREATE PDF FILES USING THE PDF CREATE ASSISTANT

Note: Selecting “Combine Files into one PDF document” creates a file containing all of the pages from the selected documents sequentially in the order they are listed in the batch process. “Overlay files as one PDF document” will result in the creation of a single document with the first file listed as the bottom layer and overlapping each of the pages of all the other file’s on top of it as additional layers.

Launch PDF Create Assistant, or within Power PDF Advanced click on the File menu and push New and then select “Create Multiple Files”

1. Click “Add” to begin selecting documents for PDF creation
2. Browse and select the documents you wish to work with
3. Make sure the drop down menu for “Create a PDF for each Input Document” is selected
4. Select the profile to use for the creation settings, PDF file creation profiles allow the user to determine specific settings (compatibility, compression, security, etc.) to be used when creating new PDF files
5. Click “OK” to begin processing
6. Your new PDF files are created in the order they were listed
7. Save each PDF file to continue processing the next application file

CREATING CREATION PROFILES

Profiles allow you to reuse settings, to share them with others and to standardize the generation of PDF within an organization. Settings control the size and compression of images, the type of PDF generated and unique to Power PDF the ability to specify a watermark at creation time.

1. Choose “File” then “New PDF” and “Create Multiple Files” which opens the PDF Create Assistant
2. Click the topmost “Profile” button
3. Click the “New” button to create a new Profile
4. Type “PDF-A” as the name of your profile to utilize the format designated for long-term PDF preservation
5. At the top of the menu change “compatible with” to “PDF/A-2U”
6. Leave all other options and click “OK”
PDF PACKAGES AND PORTFOLIOS

Creating a PDF package or Portfolio is similar to combining files with the batch creation process. PDF packages are an earlier construct of PDF Specification that have been replaced by PDF Portfolios. Portfolios can include folders and even folder hierarchies for even better presentation and organization of your files. Portfolios also offer additional presentation tools such as an introduction page, which can include Flash movies, and instructions on how the included files should be utilized. Power PDF supports both packages and portfolios but for the purposes of this guide only Portfolios will be created. The use of portfolio and package can be used interchangeably. The purpose of the portfolio is to place PDF files within a PDF wrapper. The resulting PDF is a single PDF file that when opened contains multiple documents, each retaining its own unique identity rather than being fused into one large document. All PDF content within a PDF package can be searched on from a single search, secured with a single password or printed from a single print command.

Packages & Portfolios questions to ask when considering a PDF solution:

1. Can the program do a full-content search on a long document?
2. Can I package multiple PDF documents into one file?
3. Can I include folders or a folder structure to organize my files as with Portfolios?
4. If I receive a PDF Package or Portfolio, will I be able to view it and effectively work with it?
5. Can other applications generate Portfolios and enclose non PDFs within them?
6. Can other applications view those documents within the same application frame?

CREATING A PORTFOLIO BY COMBINING MULTIPLE DOCUMENTS AND DOCUMENT TYPES

Launch PDF Create Assistant and select “Package files into one PDF document”, or within Power PDF Advanced simply click on “New Package.”

1. Click “Add” to begin selecting documents for inclusion in the package
2. Browse and select the documents you wish to work with. Note: All documents selected will be turned into PDF documents for inclusion in the package. The inclusion of non-PDF documents within a PDF package will be addressed later in this section.
3. Click “Option” and choose whether to use the default “Create Assistant Template” as the cover sheet to the package or to use the first page of the first document Click “OK” to begin processing
4. Your new PDF Package file is created
The result is this view of a PDF portfolio with the files in order and the cover page showing by default.

This PDF Package contains multiple files grouped together within a single container PDF file.

Nuance Power PDF can be used to view, create and manage the files within this container.

To get started, click any file in the PDF Portfolio to view it.

- PDF Packages group multiple files and file types together to make them easier to distribute or share.
- PDF Packages allow you to organize related files for easier viewing and printing.
- PDF Packages maintain the original security settings of the files or folders included in the container.

Note: In older viewers/editors the files are stored as attachments to this page.
PDF CONVERSION

CONVERTING PDF FILES INTO OTHER FORMATS

There are two main methods of Converting PDF documents into other formats. The first is from within Power PDF Advanced, the second is through the PDF Converter Assistant. Both methods can be invoked through the Power PDF interface and use a common set of profiles and settings to achieve the most consistent results. The converter assistant runs as a separate application and can be accessed through the task bar as well as through the.

Conversion questions to ask when considering a PDF solution:
1. Can I convert documents from PDF to Word format? If yes, how much clean-up is involved post conversion?
2. Can documents be converted from PDF to Excel or other formats?
3. Can software convert from PDF file to Office 2007 or 2010?
4. Can “static” or scanned images be converted into searchable PDF documents?

CONVERT PDF TO OFFICE & OTHER FORMATS

Converting to office formats is done through the advanced processing ribbon. There are two ways to this.
1. The batch conversion method that starts the Convert Assistant
2. The other Converter Tools with its long list of document types to convert to

CONVERT TO MICROSOFT WORD/EXCEL

1. Open a PDF document within Power PDF Advanced and scroll through it
2. Click on the Advanced Processing Ribbon and select – Other converters and select “Word Document/Excel Spreadsheet”
3. Choose a place to save the converted document and click “OK”
4. The document will be opened in Microsoft Word, scroll through the document and see that the elements in the Word document look exactly the same as the original PDF document
CONVERT IMAGE PDFS TO SEARCHABLE PDF

An Image-only PDF refers to a type of PDF file that was created either by a scanner or using a “Print as Image” setting in the PDF printer. Image-only PDF files are literally just pictures of the pages of the document with no textual information associated with them. As a result, image-only PDF files cannot support text searching, indexing or editing unless they have been converted to a Searchable PDF. A Searchable PDF refers to an Image-only PDF that has been converted using OCR. In that conversion process the text from the image-only PDF is recognized and inserted invisibly in a layer within the PDF page. The result is a file that looks like an image-only or scanned document, but has searchable text hidden within the file. You can perform text based searches, edits, comments and redaction on a searchable PDF. None of these tools are available until the file is made searchable.

This is such an important feature that it can be located in several places in the application. The first is on the Home ribbon to the left of the scan button so that scanning and OCR are linked. The other is within the Advanced Processing ribbon-Other Converters button and finally if can be found in the PDF Creation profiles as a checkbox when a profile is created. All of these come with options to control the image quality and deskew and show which characters have been rejected.

Open the PDF Create Assistant.

1. Click on the Profiles... button.
2. Select the “Searchable” checkbox.
3. Click “OK”

OCR settings can be found in the convert settings dialog when used in Advanced Processing ribbon or set as the default through the Preferences dialog box as seen below.
THE AUTO-DETECT IMAGE-ONLY FEATURE – CREATE EDITABLE PDF FILES FROM SCANNED IMAGES

If you open a scanned or image-only file, Power PDF Advanced has to ability to auto-detect that the file contains image-only pages and converts them to searchable PDF. This feature is disabled by default and re-enabled through the File: Preferences: Document: Searchable PDF Documents option.

Once enabled when an Image-only file is detected, a dialog box will open giving the user the following options:

1. If you select “Make the document fully searchable,” the application will preserve the picture of the page and add an invisible layer of text under it using OCR, or Optical Character Recognition technology. In this way, you can search for words in the document, but you're not able to edit the text.
2. If you select “Make the document fully searchable and editable,” the document will be completely converted into a text document, and the original scanned file is not maintained. The application will try to faithfully reproduce the original, but you may see some changes. The benefit of this process is that all the text can be edited, as well as searched.

3. The next option is to “Make this a fillable form using FormTyper.” You would only select this option if you scanned a form and wanted to make it actively fillable in the viewer.

4. The last option is to “take no action” if we would like to leave it as an PDF Image only file. You would choose this option if we do not need to search or edit any of the data within the file.

**EXPORT AN AREA**

Power PDF Advanced offers the ability to convert a selected area of a page into Word, Excel, PowerPoint and WordPerfect. Converting an Area is a great way to extract tables out of documents, or to simply reuse a portion of an existing document.

1. From the Advanced Processing Ribbon select the “Export Area”
2. The snapshot tool will be selected automatically in order for you to mark the area of the document you’d like to convert.
3. When the SAVE AS menu opens, name your file and simply select the file type.

![](image)

The selected area will be converted into the format that you have chosen and the application will open with this content in it.
BATCH CONVERT PDFS TO ANOTHER DOCUMENT TYPE USING THE PDF CONVERTER ASSISTANT

To convert more than one file at one time, or to merge many PDFs into a single editable PDF utilize the PDF Converter Assistant utility. This utility allows you to create a list of PDFs and then convert them to a common office or RTF format. New in this release is the ability to pick files from your connected DMS.

1. To use this utility, you can either launch the PDF Converter Assistant from the Start Menu or you can access the PDF Converter Assistant through the Converter button from the advanced processing ribbon
2. Click “Add” to begin selecting documents for PDF conversion
3. Once your PDF files are selected, you have the option to choose how you want the output to be handled under the View > Output menu
4. You can select for all to be combined into one file or converted into separate files and also the location and naming for the files to be delivered
5. Click the output document file type to define the results of the conversion
6. Click “OK” to begin processing
DOCUMENT ASSEMBLY / DOCUMENT SPLITTING

DOCUMENT ASSEMBLY

1. The document assembly button in on the Home ribbon.
2. Document Assembly is a view that allows rearranging pages and the content of pages
3. Pages can now be easily shuffled with simple Drag and Drop control

1. To add additional pages, right click: INSERT and choose additional files or pages, or simply drag and drop files, even non-PDF files, into the view. Non-PDF files will be converted to PDF prior to being inserted into the document
2. Using the Document Assembly toolbar (only available in Document Assembly view) you can Insert, Replace, Delete, and Extract, add new, rearrange...pages in the view.
3. In order to create a polished assembled document, unify your headers and footers by either updating them, or removing old headers and footers and replacing them with a new one
4. Finally, click the Renumber Pages button to correct the page numbers so that they correspond with your newly re-ordered document.
**DOCUMENT SPLITTING**

1. Open a multi-page document
2. From the Home ribbon push the Split Document button
3. Select the “Split by Pages: ___ Pages as a Document” option
4. Enter “2” in the text box, indicating that the document should be split into groups of 2 pages each and click “OK”
5. Select a folder in which to save the newly generated split files and click “OK”

Note: With these settings, a four page document will be split into two 2-page documents. The naming convention that is used for splitting documents is “Segment001 of doc name.” Choose from 8 different splitting methods to split your large document into smaller segments, including our newest addition Split By File Size.
BASIC PDF EDITING

DOCUMENT EDITING – TOUCHUP

Power PDF Advanced provides you with a Touchup Tool for editing basic content within a PDF document. Touchup Tool is designed to edit textual content and images, graphs and other elements within the document.

Editing questions to ask when considering a PDF solution:

- Can the product edit PDF document content?
- Can the product edit or manipulate graphics and charts within a PDF file?

EDIT OBJECT TOOL

1. From the Edit Ribbon select the Edit Object button
2. Click any text line and the select the floating tool tip to see the available edit operations
3. Right click in the highlighted text and select “Properties”
4. On the “Text” tab change the font to Arial Bold
5. Change the fill color to maroon
6. Change the font size to 8 point
7. Close the properties box and view your text changes

Note: In order to edit text in a document the fonts used in the document must be available on your system. If you click on the Edit Object tool and are unable to directly edit the text, that means the PDF document you are working with has text properties (font, point size, etc.) that are not available on your system. In order to edit the text you need to open the properties of the text object and change the font to one that is listed, the change the point size to one that is listed. Once you save the file you can reopen it and edit text normal.
TOUCHUP OBJECTS - RESIZING OBJECTS
1. Open the “Convert - Charts and Column.pdf” PDF file.
2. Click on the “Touchup Tool” icon.
3. Click on a slice of the pie chart to select it.
4. Resize the pie slice.

EDIT OBJECT – MOVING AND ROTATING
1. Open the “Convert - Charts and Column” PDF file
2. Click on the “Touchup Tool” icon
3. Click on the green slice of the pie chart to select it and move it out of the way
4. Click the yellow slice, move and rotate it into position where the green slice was
5. Click the green slice, move and rotate it to where the yellow slice was
COMMENTS AND ANNOTATIONS - REVIEWING FEATURES

Under the Comment ribbon are all of the annotation tools necessary to review and collaborate on documents plus powerful tools to manage the review. Using the search and markup tool you can find word or number patterns throughout the document to speed up the markup process. Using these tools you can comment or markup the document then collect comments from many sources, approve or reject comments, find comments with certain language, and check your spelling.

USING NOTES, CALLOUTS, HIGHLIGHT, UNDERLINE AND DRAW TOOLS

1. Open your PDF file
2. Select the Comment ribbon and then push the Note, Callout or Text Box buttons
3. Click in the document and then, type in some text and close the tool
4. Hover over the annotation and see how it automatically appears
5. Right click on the note and select “Reply” to add comments
6. A new blank note window opens within the old one
7. Callouts and Text boxes cannot be replied to, they are part of the comment summary and can be treated like other annotations by using the right click to set status or confirm migration
8. To view all the comments in a document push the Comments panel button in the comments ribbon

USING DRAGON NOTES TO COMMENT

Enter notes in PDF files by dictating text with the Dragon Notes speech recognition engine from inside of Power PDF Advanced. The user dictates into their microphone and the speech is transmitted to the Nuance server in the cloud for processing. After the speech has been processed and recognized, it will appear as transcribed text in the Sticky Note. The speech processing is performed seamlessly, and no account, registration or training is required.

DRAGON NOTES REQUIREMENTS:

An active internet connection is required to use Dragon Notes, as the speech is not processed locally. The speech the user dictates will be processed by the Dragon Notes server and the dictation results will be returned to Power PDF Advanced. Dragon Notes also requires the user to have a microphone that accepts speech input. The microphone should be configured in the Windows Control Panel and set to the default recording device. Any time an annotation box is open – Text Box, Callout, comment, highlight, Note, cross out etc. you can speak into the note and your comment will be recorded as text.
**DRAWING TOOLS**

Drawing tools are also annotations that can be added to the document. They are used to draw attention to something on the page and enable the use of a note box to convey the meaning. These comments are summarized in the comments panel just like other annotations. Also like other annotations drawing tools have properties, history, status, etc.

1. From within the Comments ribbon pull down the drawing tool button and select Oval
2. You use this tool to circle objects and write comments on them
3. If the object has readable text then that text will populate the draw tool note box
4. Right click on the oval to review properties options

![Image of drawing tool and oval properties]

**ACTIVE MARKUP TOOL**

The active markup tool is a collection of the different review tools found in most document editors today. There is a tool for highlight, cross out, underline, insert, delete. This tool is slightly different from the markup tools themselves because it shows insert marks where the replacement text or other changes should go.

1. Click on the Active Markup drop down button, select text markup tool
2. Click on the text you’d like to annotate and type into the note box
3. To insert text: select a location and then type into the note box that appears
4. The notes will appear in the comments summary and they can be managed through status or replies within the note box itself

![Image of active markup tool and text insertion]
COMMENTS

PRINTING COMMENTS
1. To print comments select the File menu and Print with comments
2. Choose a layout based on where you want the comments to appear on the page - “linked to the text on the page” or on “separate pages”
3. Print comments sorted by author, date, page or type

MIGRATING COMMENTS
Power PDF Advanced offers the ability to migrate comments from reviewed versions of your document, in order to have a complete set of revision statements within a single, “master” document.

With a document open, open the comments panel by clicking the Comments button on the bottom window frame or by pushing the Comments Panel button in the Comments ribbon. Click on Options and select Migrate Comments.

1. Within the Source file drop-down select Open a File
2. Select the file from which you’d like to pull comments, and click OK
3. All comments from the source document will be pulled into the open document and migrated into the comments panel

If you migrate comments from multiple PDFs, there is a checkbox that allows you to filter the comments that are presented in the master document. If you want to view all comments regardless of their status then check the box on the migrate dialog. This box only affects the view of the comments; all annotations are migrated to the master document regardless of this checkbox.

MANAGING COMMENTS - REPLY, ACCEPT OR REJECT
Replying or changing the status of comments is very flexible. You can use the comments panel to go through them as a list, you can create a summary view of the file with annotations listed sequentially within the document or you can use the normal view and open each annotation individually and change the status. All of these methods use a common tool set – the directions below can be applied to any view method.

Comments collected from reviews can be managed individually. The “owner” of the document can decide whether to accept, reject or reply to a comment.

1. Within the Comments panel click on a comment
2. Click on Set Status and select Review from the menu
3. For that selected comment you can choose whether to mark the comment as Accepted, Rejected, Cancelled, or Completed
4. Additionally by clicking on the Reply button within the Comments panel you can reply to individual comments. All comments can be replied to, accepted, or rejected

WATCHED FOLDER AND BATCH SEQUENCES

WATCHED FOLDERS
One of the key new capabilities of Power PDF si the ability to create a watched folder to automate the generation of PDFs from many formats including image, Office, PDFs, HTML and txt files. This type of automation is important for workgroups of all sizes because it allows initial document preparation to be automated. This is a simple tool with powerful capabilities to transform documents from one format into a searchable PDF, an archive PDF/A file or a TIFF/multi-page TIFF.

1. Navigate to the Advanced Processing ribbon and push the Batch Controls drop down button
2. Select the Watched Folder item
3. Enter an input folder to watch, select and control the type of files to be converted
4. Select an output folder and select the type of conversion required
5. Then determine what to do with the original files – delete, move them, leave them where they are

**BATCH SEQUENCES**

Batch sequences allow you to string together many different commands into a single command that will be performed on the files indicated in the file list. Batch sequences are good for removing cover pages, finding word patterns, stamping, watering marking etc. The list of supported commands is extensive. If there are processes you do repetitively then batch sequences may be a good tool to consider.

1. From the Advanced Processing ribbon select the Workflow button
2. Name the sequence in the first dialog
3. Select the commands that you want to sequence

1. This sequence will find the instances of Asian and mark them for redaction. Then it marks the pages as confidential. The actual redaction will not be done until redaction is performed on the file by a user.
2. The marks are saved as an annotation layer so you can use Comments Panel to view them like any other note or callout. Because the batch sequence can act on more than one file at a time you could for example, find all the instances of a word in all the files in a folder and then show the instances using the Comments Panel.
Additional document Search and redaction capabilities

SEARCH

From the Home ribbon there is a powerful search tool that can be used to find all the instances of a word or number pattern in the current file, PDF Portfolio or Windows directory. The parameters allow the user to look for a word or phrase, multiple words or phrases or use standard or customized number patterns. This feature creates a list of conforming files and allows the user to carefully examine the instances where the target was found.

1. From the Home ribbon select the Search drop down and choose search multiple
2. Choose the volume of files to examine – single through entire directories
3. Choose the word, phrase or pattern to search for
4. The results are displayed as a clickable file list
5. The file will be opened with the instances highlighted

SEARCH AND REDACT

Similar to Search, the Search and Redact feature can traverse multiple files or directories to find the search target. It uses the same simple search UI but marks the results for redaction.

1. From the Security ribbon select the Search and Redact button
2. Choose the volume of files to examine – single through entire directories
3. In this case choose a US phone number to find all of the instances of private party numbers in the document
4. The results are displayed as a clickable file list
5. The file will be opened with the instances highlighted

Of course these are marked as annotation as described above so they can be summarized in the comments panel or other annotation tools can be used to find and manage them.

DOCUMENT COMPARISON

Document comparison tools provide a fast and easy mechanism for identifying differences between two versions of a document. Options can include side-by-side comparisons or combined views as well as PDF to PDF and PDF to Word comparisons. There was substantial work done to improve the usability and the comparison algorithm for this release.

DOCUMENT COMPARISON – PDF TO PDF

1. Open a PDF file within Power PDF Advanced.
2. Edit some text and move some objects within the document as described in the Document Editing section of this document and save it as a new file name.
3. From the Home Ribbon push the Compare button
4. Use the browse buttons to select the older and newer versions of the document for comparison.
5. Ensure View Visual and Textual differences is selected (in order to detect image changes as well as textual) and that Side by side comparison is selected.

6. Then click OK.

1. After a summary page a side-by-side comparison report is generated identifying the differences between the two documents
2. Side-by-side document comparison saves time and accurately detects differences between revisions
CONCLUSION

This guide should have given you a good idea of the capabilities of the Power PDF application. The features and user experience are designed for ease of navigation in a highly efficient office environment. All features will scale with your organization so they are useful in a one person office as well as a workgroup of 100s. Power PDF will provide an uncompromised experience. Documents of 1 to 1000s of pages can be managed with ease. Volumes of documents from single files, entire directories and ongoing watched folders are all accommodated with easy to use dialogs and well organized results. Enjoy the power you have at your fingertips with Power PDF.